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ConTaCT InformaTIon
Your local dealer can provide the latest information about product offerings and new 
technology support. Contact information for your local dealer can be obtained from our web 
site, or by contacting our offices directly.

Internet

www.cadlink.com

UnIted StateS

500 Main Street

Clinton, MA 01510

Tel: 1-800-545-9581

Fax: (613) 247-1488

Canada

2150 Thurston Drive

Ottawa, ON K1G 5T9

Tel: (613) 247-0850

Fax: (613) 247-1488

e-maIl

sales@cadlink.com

UnIted KIngdom

Intech House, Wilbury Way

Hitchin, Herts SG4 0TW

Tel: ++44(0) 1462-420222

Fax: ++44(0) 1462-420111

deUtSChland

Georg Christoph Neller Str. 3

D-54296 Trier

Tel: +49(0) 651-96644840

Fax: +49(0) 651-96644841

Contact Information
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lImITed WarranTy on CadlInk ProduCTs 
CADlink warrants that the disk medium upon which the product is recorded, and any hardware 
accompanying said disk(s), shall be free from defects in materials and workmanship -- under normal use and 
service for a period of ninety (90) days from the date of delivery, as evidenced by a copy of the receipt.

CADlink’s entire liability and exclusive remedy as to the disk(s) or hardware shall be at CADlink’s option 
-- either (a) return of the purchase price, or (b) replacement of the disk(s) or hardware that do not meet 
CADlink’s Limited Warranty. These must be returned to CADlink postage pre-paid with a copy of the 
receipt.

If failure of the disk(s) or hardware has resulted from accident, abuse or misapplication, CADlink shall have 
no responsibility to replace the disk(s) or hardware, the replacement will be warranted for the remainder 
of the original warranty period or thirty (30) days, whichever is longer. Other then the above limited 
warranty, CADlink makes no other warranties whatsoever, either legal or conventional, express or implied, 
with respect to the licensed software and hardware. You are advised to test the licensed software thoroughly 
before relying on it. You assume the entire risk of using the licensed software. Because of the diversity of 
conditions and hardware under which the licensed software may be used, no warranty of merchantability or 
fitness for a particular purpose is given. Some regions do not allow the exclusion of implied warranties, so 
the above exclusion may not apply.

CoPyrIghT noTICe
No part of this publication may be reproduced mechanically or electronically or in any form without the 
prior written permission of CADlink. The software described in this manual is furnished under license 
and may only be used or copied in accordance with the terms of such license. The information in this 
manual is for informational use only, is subject to change without notice and should not be construed as a 
commitment by CADlink. CADlink assumes no responsibility or liability for any errors or inaccuracies that 
may appear in this document. FilmMaker® is a registered trademark of CADlink Technology Corporation.

Written and designed at CADlink
2150 Thurston Drive, Ottawa, ON, Canada, K1G 5T9
Phone (613) 247-0850 Fax (613) 247-1488
Manual & Package Design by CADlink Marketing and Customer Support.
Printed in Canada. Product of Canada.
© June 2013, CADlink Technology Corporation

Limited Warranty and Copyright
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InTroduCTIon To PrInTIng WITh fIlmmaker
FilmMaker enhances and streamlines your Epson print applications and screen 
preparations, and (with the exception of the Epson 1400 and R1800) provides Variable 
Dot Halftone (V-dot) support. With V-dot support, this increases the available number 
of shades by a factor of (times) 3 for a single black channel, and this process works across 
multiple black channels to provide up to (times) 12 shades. The net results are higher 
quality separations that can be produced in less time.

Note that not all features described within this manual and the electronic help may apply 
to your printer model and version of FilmMaker. It is expected that you have read and 
understood the Operator’s Manual that was provided with your printer, and that you are 
aware of the printer’s capabilities. For example, the Epson Photo Stylus R1800 is the only 
model listed that does not support Variable Dot Halftones. As such, FilmMaker supports 
high quality halftones for the Photo Stylus R1800, though not the additional multiples of 
shades that are achievable using V-dot technology.

WhaT should neW users of fIlmmaker knoW?
Before describing the new features, the following are previous features that are good for 
new FilmMaker users to understand.

Queue-based Production Management
For each of your printers, you can create a queue tab that collects jobs according to the 
printer. Further, you can create additional tabs that vary only slightly, so as to segregate 
certain types of job.

Depending upon your workflow, a queue can be configured to appear like a printer 
destination to other Windows applications.

Hot Folders for Printing from Mac OSX
Though FilmMaker is a Windows application, print jobs can be processed from other 
operating systems (i.e., Mac OSX) by using a Hot Folder, which is simply a directory that 
FilmMaker monitors for image files that should be printed. See “Part 6 – Using a Hot 
Folder with Mac OSX” on page 17.

Extra Resolution Presets for Variable Dot Printing
For certain printer models that support variable dot printing, there is a Resolution printer 
option that provides an assortment of preset resolution and dot size combinations that can 
be used to fine tune the ink density for your films.

Send to FilmMaker Shortcut
When FilmMaker is installed, a “Send to FilmMaker” shortcut is added to your PhotoShop 
package. This shortcut will quickly send jobs to FilmMaker without the need to configure 
the File menu >> Print dialog. FilmMaker receives each job as a set of print-ready 
separations. See “Separations in PhotoShop®” on page 25.

FilmMaker Quick Start
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Previewing Raw Print Data
For a held job, it can be spooled without printing, and then the print data then previewed 
on-screen as a pixel-by-pixel display of the actual print output. Monitor technology is 
only capable of an approximation of the job colours, though the pixel-accurate display is a 
useful tool for confirming the ink distribution across the job. See “Previewing Print Data” 
on page 40.

WhaT’s neW for PrevIous users?
For those that are experienced with previous incarnations of our software, the following 
summaries should help you get a glimmer of the new and improved features in 
FilmMaker.

Printer and Queue Setup Wizard
When launching FilmMaker for the first time, there is a new wizard for printer 
configuration and queue creation for collecting jobs that will be output by that printer. 
The wizard can be repeated to create queues for other printers. If there is an alternative 
configuration that you sometimes want to use for your printer, then use the wizard 
to create a separate queue with those settings. See “Part 3 – Printer and Queue Setup 
Wizard” on page 12.

Ink Density Wizard
After completing the Printer and Queue Setup wizard, the Ink Density Wizard provides 
an opportunity to print a series of sample targets that help you determine the optimum 
ink density for your printer. This wizard can be repeated from the Queue menu. See “Part 
4 – Ink Density Wizard” on page 15.

In-RIP Separations
Instead of using your graphic design software to create separation, FilmMaker can now 
automatically generate separations for the CMYK planes, plus any spot colours that are 
present. For example, importing a PDF into FilmMaker will cause separations to be 
created, unless separations already exist within the file. See “In-RIP Separations” on page 
44.

Separate Curve Set Options
When In-RIP Separations are enabled, distinct sets of curve information can be defined for 
your prepress proofing and main production work. This allows you to adjust the ink levels 
for each process independently. See “In-RIP Separations” on page 44.

Jitter
For the halftone dots that compose a print job, Jitter is a means of introducing minute 
randomness to the dot shape, such that patterns are less evident within the halftone. The 
amount of Jitter can be adjusted for different tint ranges, such that the shadows, midtones, 
and highlights can each have independently set Jitter amounts. See “Jitter” on page 44.

Introduction
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geTTIng sTarTed WITh InsTallIng fIlmmaker
FilmMaker is provided with a USB security device to prevent unauthorized use or pirating 
of the software. This device plugs into a standard USB port of the computer, and it is 
transparent to other applications. Only FilmMaker is aware of the device.

Policy On Lost Or Stolen   Security Devices

 ☐ The USB security device provided with FilmMaker is your proof of purchase. If 
the dongle is lost or stolen, then that is equivalent to losing the entire software 
package, and a new package of FilmMaker must be purchased.

 ☐ In the event of a damaged security device that must be replaced, there is a 
nominal fee for EXCHANGING a new device for the older device, where the 
older device must be reclaimed by CADlink.

This fee is waived where product is still under warranty.

 ☐ Regardless, it is recommended that you ensure that your security device is 
covered under your business insurance policy.

Temporary  License Files

 ☐ License fi les are included with your USB dongle, which are used to confi rm the 
features within your CADlink products.

 ☐ If a replacement dongle is being shipped to you, then you will typically be 
issued “temporary” license fi les that will enable you to continue using your 
CADlink products.

 ☐ Temporary license fi les will cease working after a set criteria, though the 
expectation is that your replacement dongle will arrive prior to expiry.

 ☐ Please note that the replacement dongle will be provided with new “permanent” 
license fi les that will replace the temporary license fi les.

Connect your orange dongle 
BEFORE installing your 
FilmMaker software!

FilmMaker Quick Start
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Storing Your License Files

 ☐ In the event of lost license files, there is a nominal administrative fee for issuing 
replacement license files.

The fee is waived if the Free Support period is still active. Otherwise, 
replacement license file issues are treated like Tech Support requests.

 ☐ When CADlink sends you new license files, it is important that you create 
backups of the license files, so they can be easily located when re-installing your 
CADlink products on new equipment.

 ☐ In the case of the orange USB flash drive dongle, your license files can be stored 
on the dongle itself. When re-installing your CADlink products, license files 
upon the dongle will be automatically used.

ParT 1 – Program InsTallaTIon

At this point, you have confirmed that your FilmMaker package contains both the 
installation CD and security device. The following steps are an overview of installing 
FilmMaker. Within the installation wizard, further information is provided with each 
individual stage of the wizard.

1. Connect the USB security device NOW.

2. Insert the FilmMaker install CD into your CD-ROM drive. The install wizard should 
“auto start”.

If the install wizard fails to auto start, then you will need to start the installation 
process manually, as follows:.

a. From the Start menu, choose Run to open the Run dialog.

For Windows 8, use [Windows + r]

b. Click Browse and locate the setup.exe file that is on the CD in the CD-
ROM drive.

c. Click Open to choose the setup.exe file, and click OK to close the Run 
dialog.

3. After the installation is complete, click Finish to conclude the install wizard. Proceed 
to “Part 2 – Printer Installation and Setup”.

Installing FilmMaker
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ParT 2 – PrInTer InsTallaTIon and seTuP

After FilmMaker has been installed, you are ready to launch FilmMaker and send a print 
job.

Note: Your FilmMaker install CD should still be in the CD-ROM drive, such 
that printer support files can now be installed.

1. From the Start menu programs flyout, choose FilmMaker.

2. The Printer and Queue Setup Wizard will launch, which will guide you through 
the steps to install your initial printer and configure its queue for managing print 
jobs. Proceed to “Part 3 – Printer and Queue Setup Wizard”.

ParT 3 – PrInTer and Queue seTuP WIzard

Note: The number of wizard pages will vary according to your printer choice.

FilmMaker is a queue-based production manager, meaning that two-or-more jobs can be 
accumulated and sorted according to their job parameters. For example, a separate queue 
should be created and assigned to each printer. Likewise, multiple queues can be created 
for a given printer, where each queue is used to accumulate jobs for a specific type of 
media.

From a designer’s standpoint, each queue is like a print destination that they can print to 
via File menu >> Print in their graphic design application (Fig. 1). The designer would 
choose the queue that best corresponds to the type of job they want processed.

By using the queues to accumulate jobs from various designers, jobs can be held pending, 
until the given printer is available, or a given roll of media has been loaded, etc.

The Printer and Queue Setup Wizard will prompt you to configure a queue for your 
printer. Each wizard page prompts you for information about how you want the queue 

Fig. 1  - When the printer name is chosen, the description should 
indicate that this is a FilmMaker printer driver. Otherwise, check the list 
again for a similarly named printer.

FilmMaker Quick Start
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to be configured, and the sequence of pages will vary according to your choices. The 
following sections elaborate on some of the wizard pages that you might encounter.

Queue Type

The wizard pages will vary according to what type of printing you want to perform. The 
choices are:

A. Film Separations: Use this option where black ink will be used to print 
separations for each of the main colour components (i.e., CMYK, plus any spot 
colours).

B. Sublimation Transfers or Colour Printing: Use this option where colour inks 
(i.e., CMYK) will be used print an image in one-or-more passes.

prinTer insTallaTion and ConneCTion

You are now prompted to choose the printer and output port. Click [...] to configure the 
port.

Before clicking Next, please confirm that your printer is connected to the indicated port, 
and that the printer is ready for printing. Later in the wizard, you will be asked to print 
one-or-more test pages that will aid you in choosing the optimum ink settings for your 
printer.

There are a variety of output ports supported, though the following two are the most 
widely used:

 ☐ TCP/IP - Choose this option for printers that are connected to your network via 
Ethernet connectors.

 ☐ USB - Choose this option for printers that are connected via USB port. If the 
printer is connected to a USB hub, then confirm with the printer manufacturer 
whether a powered USB hub is necessary.

Clicking Next will proceed with installing the support files for the printer.

Media seTup

The available media choices will depend upon the printer model.

A. Roll Media - When printing to a roll, it is common to perform either automatic 
or manual nesting.

B. Sheet Media - Use the page size set within FilmMaker. Typically, this is done 
when incoming jobs are intended for a fixed sheet size, or assorted jobs will be 
nested upon the sheet.

Installing FilmMaker

FilmMaker4_QuickStart_A4.indd   13 2013-07-05   11:58 AM



14

Choosing Roll versus Sheet Media
The choice of roll versus sheet media largely depends upon user preference. 
However, the following are some printer-specific notes:

 ☐ The Epson 1400 is sheet feed only.

 ☐ The Epson 1800 has limited roll feed functionality, and it is 
recommended that the 1800 only be used for printing sheets.

 ☐ For the Epson 4800/7800/9800 series printers, and Roland VP-
540, roll media is generally preferred.

 ☐ For roll mode, you most likely want to configure for auto nesting 
or manual nesting.

Note: Printer notes and comments are listed in Appendix A.

prinTer ConfiguraTion

The Resolution refers to the quality at which the FilmMaker RIP will process jobs 
through this queue before sending data to the printer. The choices somewhat depend upon 
what ink you are using, and how many channels are being used to print black ink.

 ☐ Higher resolutions increase the print quality, including high line screens, 
though more time will be required for calculations.

 ☐ Higher resolution applies more ink, so greater ink density will be obtained.

 ☐ If greater ink density is desirable, then more ink would be obtained by choosing 
a resolution that indicated a larger dot size (i.e., SmallDots >> BigDots).

 ☐ Note that “MD” is sometimes used to indicate “Maximum Dot.”

Choose the Resolution that best corresponds to the jobs that the printer will be expected 
to perform. If there are alternative Resolution settings that you believe would be 
occasionally useful, then after you complete this wizard, you can use the wizard to create 
additional queues using the alternative resolutions that you need. In this manner, print 
jobs can be sorted by sending them to the queue that has the desired Resolution setting.

For printers that have multiple ink channels, the Ink Setup is used to define which of 
these channels have been loaded with black ink. For example, consider the following four 
choices:

 ☐ Multiple Black Matte

 ☐ Multiple Black Photo

 ☐ Single Black Matte

 ☐ Single Black Photo

FilmMaker Quick Start
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The “multiple” options indicate printers that have more than one ink channel, for which 
you will be provided checkboxes to identify any additional channels that have been loaded 
with black ink.

HalfTone sCreening

The halftone refers to the pattern wherein the printer will apply dots of ink. The intent 
is to avoid obvious patterns that distract from the finished print. Though your graphic 
design application can be capable of providing halftone information with your print jobs, 
it is recommended that FilmMaker be used to generate the halftone.

If there is doubt about the best halftone settings, then choose the defaults for now, and 
consult the Halftone Screening sections for more information. If you need different 
halftone settings, then you can change them later using the Queue Properties dialog. 

naMe your produCTion Queue

After completing this wizard, a queue will be created using the unique name specified 
here. This wizard can be used multiple times to create more queues, and in production you 
will be able to switch between queues by clicking its named tab.

prinTer and Queue seTup CoMpleTed

At this point, queue creation is complete, and you can click Save to continue.

 ☐ If you are creating a queue for film separations, then proceed to “Part 4 - Ink 
Density Wizard“.

 ☐ If you are creating a queue for sublimation transfers or colour printing, then 
proceed to “Part 5 - Test Print to FilmMaker”.

ParT 4 – Ink densITy WIzard

Ink density is the primary factor that affects printed film quality. For example, too little 
ink can cause fuzzy dots when exposing the film, whereas too much ink increases drying 
time and risks bleeding between halftone dots. Despite these risks, it is desirable to 
achieve the highest possible ink density because of the higher film quality that can be 
obtained at lower print resolutions.

FilmMaker will launch when completing the Printer and Queue Setup Wizard. If you 
have created a queue for film separations, then you now have the option of continuing with 
the one-page Ink Density Wizard, which involves printing sample targets to determine 
the optimum ink density for your printer.

Note: The Ink Density Wizard can be re-launched via Queue menu >> Ink 
Density Test Page.

1. Follow the wizard steps as indicated.

2. Of the two Print Test Page buttons, click the “low ink level” button.

3. In the FilmMaker window, an “Ink Density Target” job will be placed in the 

Installing FilmMaker
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queue for your printer.

4. When this job is printed, you will see that it is a collection of tint swatches that 
vary by volume of ink.

5. The goal is to visually inspect (or optionally use a densitometer) to determine 
the swatches that have obtained the best result.

6. Optionally, you can click the “high ink level” button to print tint swatches at a 
greater volume of ink.

7. For step (3) of the Ink Density Wizard, enter the swatch number that had 
obtained the best result.

Once the Ink Density Wizard is complete, proceed to “Part 5 – Test Print to FilmMaker”.

ParT 5 – TesT PrInT To fIlmmaker

Printing to FilmMaker is like printing to a desktop printer. For example, suppose that 
your graphic design application uses the standard Print dialog.

1. From the design application File menu, choose Print to open the Print dialog.

2. Choose the printer name from the drop-list.

 The printer description should indicate that it is a “FilmMaker” or “CADlink” 
type of print destination, which indicates that print jobs will be processed through 
FilmMaker.

3. If the printer description does not indicate “FilmMaker,” then search for another 
(similar) printer name from the drop-list.

4. From the Print dialog, click OK to send the print job.

5. In FilmMaker, right-click the received job and choose Print from the context menu.

 If your job is unexpectedly nested into multiple jobs, or your multiple page job is 
layered into a single job, then please refer to “Page Overlay” on page 35.

Completing the above steps confirms that FilmMaker has been configured properly to 
receive and print jobs.

FilmMaker Quick Start
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ParT 6 – usIng a hoT folder WITh maC osX
FilmMaker can designate a “hot folder,” wherein any job files placed within that folder 
will be automatically processed by FilmMaker. In this manner, though FilmMaker is a 
Windows application, Mac OSX users on your network can print jobs to FilmMaker.

Create an Empty Hot Folder

1. Create an empty directory on your FilmMaker computer, or elsewhere on your 
network. This will be your Hot Folder, which must satisfy the following two 
conditions:

a. The FilmMaker computer must have login permission to read and write to 
the Hot Folder. 

b. Your graphic designers must have file write permissions to the Hot Folder.

In FilmMaker

2. Choose Queue menu >> Properties.

3. Click the Hot Folders tab.

4. Tick the Enable queue hot folder checkbox, which opens a browse dialog.

5. Browse to the folder created in step (1). Please note that the Hot Folder must be 
empty when it is initially chosen.

Note: Sometimes the operating system can place hidden files in a directory.

6. Click OK to accept the Hot Folder path.

7. Click OK to close the Queue Properties dialog.

In the Design Application

8. In the design application, prepare the print design.

9. Choose File menu >> Print (or the equivalent according to the software being 
used).

If it is permitted by the design software, then the design file can be “printed” to 
a data file that is placed directly into the Hot Folder. In this manner, printing 
will be seamless because FilmMaker will automatically process the file.

Alternatively, Export the design file in a commonly accepted format (e.g., EPS, 
AI, PDF, BMP, JPEG, TIFF, etc.), and copy the design file into the Hot Folder.

Note: Some design software create a temporary, intermediary file that 
FilmMaker does not recognize (i.e., FilmMaker will report that it does not 
recognize the intermediary file). Avoid exporting the design file directly 
into the Hot Folder.

Installing FilmMaker
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WorkIng WITh seParaTIons and halfTones

obTaInIng PhoTorealIsTIC PrInTs

Screen printing of hand-drawn art is traditionally performed through the combination of 
spot colours, where each colour is applied to a specific region of the substrate (i.e., paper, 
T-shirt, etc.). Having an overlap between colour regions can be useful in achieving a 
specific visual result, or to create the appearance of more colours than the number of inks 
used.

For computer generated art and photographic images, the complexity of the artwork can 
produce difficulties in obtaining the desired quality. If the customer expects photorealistic 
prints, then using spot colours can risk a print that appears too posterized (e.g., splotchy 
with abrupt colour shifts).

To produce photorealistic prints, a common technique is to prepare the artwork as a set 
of CMYK separations, which are then used to print the artwork on a 4-colour press (i.e., 
spot cyan, spot magenta, spot yellow, and spot black). Overprinting these spot colours will 
reproduce the colours of the original artwork.

The printing of CMYK separations uses halftones, which are a classic printing technology 
that enables the printing of detailed images with a minimum of inks. Indeed, each colour 
separation is a halftone.

 ☐ A halftone is a means of applying gradient dot patterns using a single ink, such 
that the dots form different shades (tints) of the ink.

 ☐ Where the dots are small, they will appear further apart, which produces a light 
shade of the colour that is closer to the substrate colour (i.e., a white or black 
shirt).

 ☐ Similarly, larger dots will appear closer together, which produces a darker shade 
that is similar to a solid fill of the ink.

In Fig. 2, there are three distinct regions that are crucial to quality printing: Shadows, 
Midtones, and Highlights.

Fig. 2  - An image has three distinct regions: the Shadows, Midtones, and Highlights.
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THe sHadows

 ☐ These are the darkest regions of the image, where halftone dots are largest and 
risk blending together.

 ☐ On a tint scale of [0..100%], shadows would consist of (roughly) the [85..100%] 
tint region of the image.

 ☐ The challenge with shadows is that the dots blend together and obscure the 
darkest details of the image.

THe HigHligHTs

 ☐ These are the lightest regions of the image, where halftone dots are smallest and 
appear spaced apart.

 ☐ On a tint scale of [0%..100%], highlights would consist of (roughly) the 
[0..15%] tint region of the image.

 ☐ The challenge with highlights is that the individual dots, when used to expose 
emulsion, can be inadvertently washed away with the unexposed emulsion.

 ☐ It is often difficult to retain dots in the 5% range, and there are often challenges 
with any dots less than 10% tint.

THe MidTones

 ☐ These are the mid-range regions of the image between the shadows and the 
highlights.

 ☐ On a tint scale of [0%..100%], midtones would consist of the [15..85%] tint 
region of the image.

 ☐ For midtones, the individual dots will vary according to the image details. A 
concern with midtones can occur when too much ink has been absorbed by the 
substrate, such that image details are lost (e.g., the detail in a person’s hair, or 
the texture of a grassy field).

FilmMaker Quick Start
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ChoosIng halfTone seTTIngs

Each CMYK colour separation has is its own halftone (Fig. 3). As such, each separation 
will have its own shadows, midtones, and highlights according to the strength of that 
colour component in the original image.

 ☐ During the fi nal printing process, cyan ink is printed using the cyan separation, 
magenta is printed atop this with the magenta separation, and so on.

 ☐ Correct alignment of the separations is crucial to reproduce the original image.

Note: The actual order in which the colours are printed can vary. The general 
rule is that yellow is printed last to avoid obscuring the yellow halftone dots.

Depending upon the application, there can be several methods of producing CMYK colour 
separations. When creating such separations, the halftone settings for each separation must 
be specifi ed. The terminology can vary, but generally the halftone controls will be Dot 
Shape, Frequency, and Angle.

doT sHape

Depending on the software application, there are a wide variety of shapes to choose for 
your halftone dots. The choice of shape depends on what you consider to produce good 
detail in your prints. For example, round and elliptical shapes are common, though test 
prints can determine whether other shapes are valid for a given artwork.

Fig. 3   - Each separation is like the dot pattern for the given 
colour channel. Combining the separations reproduces the 
desired colour image.
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freQuenCy

The halftone frequency is measured in Lines Per Inch (lpi), which indicates the resolution 
of the dot shape. 

 ☐ There is a Ratio between the frequency of your halftones, and the mesh count 
used when printing.

 ☐ As a rough guide for screen printing, this Ratio varies from 3 to 5, and it is used 
to avoid losing the highlight dots of the halftone. If unsure, then use a ratio of 4.

 ☐ If you have already chosen a mesh that is appropriate for your artwork, then the  
Frequency = Mesh Count / Ratio.

 ☐ Conversely, if you know the halftone frequency that is appropriate for your 
artwork, then the Mesh Count = Frequency * Ratio.

Note: When designing artwork in your graphic software application, the 
best image resolution can be determined by Resolution = Frequency * 2.5, 
which will help to avoid creating undersized dots in the highlight areas of the 
halftone.

angle

To avoid unexpected patterns from appearing in the final print, each of the CMYK 
separations must be printed at specific angles. The choice of angles is quite subjective, 
though specific angles may be preferred according to the printing technology being used.

offSet PrIntIng

As a starting point for comparison, a typical set of (CMYK) angles for offset printing is 
(108, 161, 90, and 45). Other combinations of angles can be equally valid, provided that 
consistent results are produced. For example, guidelines for other offset angles are:

 ☐ Black is always set at 45º

 ☐ The halftones should be offset by 30º from each other

 ☐ No two angles should be at right angles to one another (i.e. 90º between two 
halftone angles)

 ☐ To help prevent right angles, Yellow is set at 90º (i.e., 45º between Black and 
Yellow). Yellow is chosen for this angle because it is the least noticeable colour 
at this angle

FilmMaker Quick Start
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SCreenPrInt and flexograPhy (flexo)
In comparison to typical offset printing angles, here are typical (CMYK) angles used with 
screen printing in combination with flexographic techniques:

Cyan (C) Magenta (M) Yellow (Y) Black (K)

7.5 37.5 22.5 67.5

22.5 52.5 7.5 82.5

20 50 5 80

22.5 112.5 52.5 142.5

 ☐ Spot colours are typically printed at the same angle as Yellow.

 ☐ Though screen printing typically makes use of an Elliptical dot shape, flexo 
generally uses a Round dot shape.

lIthograPhy and flexograPhy

For lithographic techniques in combination with flexography, typical (CMYK) angles are:

Cyan (C) Magenta (M) Yellow (Y) Black (K)

15 75 90 45

105 75 0 45

0 60 15 30

0 30 15 90

 ☐ Spot colours are typically printed at the same angle as Yellow.

 ☐ Flexo generally uses a Round dot shape.

t-ShIrt graPhICS

Common (CMYK) angles for T-shirt printing are:

Cyan (C) Magenta (M) Yellow (Y) Black (K)

15 45 75 75

22.5 52.5 82.5 82.5

 ☐ Though unconventional, good results are achieved by printing spot colours 
(including spot white) at an angle of either 15 or 22.5 degrees.

 ☐ Typically want to use an Elliptical dot shape.

 ☐ For an automatic press, use a Frequency of 65 lpi in combination with a 355 
Mesh Count.

 ☐ For a manual press, use a Frequency of 55 lpi in combination with either a 305 
or 330 Mesh Count.
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CreaTIng seParaTIons In fIlmmaker

Queue menu >> Properties >> Calibration Control >> In-RIP Separations

Whereas it is often the case that your graphic design software can create separations, 
enabling the In-RIP Separations checkbox will cause the FilmMaker RIP to 
automatically generate separations for the CMYK planes, plus any spot colours that are 
present.

Primarily, the advantage of In-RIP Separations is that separations can be generated from 
(say) a PDF file, rather than needing graphic design software to generate the separations 
for you. In addition, you can specify the halftone for each separation.

In-RIP Separations are enabled by default. However, FilmMaker will only create 
separations for jobs that have not already been prepared as separations.

Note that In-RIP Separations has two Curve Set options that are used when your 
workflow involves twin parallel printing processes. This allows you to adjust the ink levels 
of each process independently.

 ☐ Calibration - Adjust this set of curves for your prepress proofing, or for printing 
the customer proof that will be used for approval before entering full production.

 ☐ Press Calibration - Adjust this set of curves for your main print production run.

ChoosIng IndIvIdual seParaTIons

When separations for a job have been received in FilmMaker, the individual separations 
can be selected for output as follows:

1. For the selected job in FilmMaker, click the Pages button (Fig. 4).
Alternatively, right-click the job and choose Pages.

2. The separations will be displayed in the Page Manager dialog.

3. Clicking a given separation will toggle it OFF (i.e., greyed out), which 
indicates that it will not be printed. Clicking the separation will toggle it ON 
(i.e., active).

4. After toggling OFF the desired separations, click the Apply button.

5. Only the active separations will be available in the Visual Print Manager.

sPlITTIng seParaTIons InTo IndIvIdual Jobs

By default, separations for a job are grouped and displayed as if they were a single job, 
though the Visual Print Manager can be used to inspect the individual separations. To 
ungroup these separations and display each separation like an individual job:

 ☐ Right-click the job and choose Split Pages.

Note that splitting separations into individual pages cannot be reversed.

FilmMaker Quick Start

FilmMaker4_QuickStart_A4.indd   24 2013-07-05   11:58 AM



25

seParaTIons In oTher aPPlICaTIons

If In-RIP Separations are not enabled, then separations must be created in your graphic 
design software. The following sections provide specific procedures for creating and 
printing separations. The controls described in the following sections can vary between 
software versions, and it may be necessary to consult the help file for your graphic design 
application.

separaTions in pHoTosHop®

Note: The following procedure is valid for any of the PhotoShop CS series.

For PhotoShop, the Send to FilmMaker shortcut is a quick means of sending separations 
to FilmMaker without configuring the File menu >> Print dialog. The given job will be 
received in FilmMaker as a set of print-ready separations, per the queue properties.

Installing the Send to FilmMaker Shortcut
If PhotoShop is present when FilmMaker is installed, then a File menu >> Automate >> 
Send to FilmMaker shortcut will be added to PhotoShop. This shortcut will allow you to 
quickly send jobs directly to any production queue that has been configured in FilmMaker.

If PhotoShop is installed after FilmMaker, then the Send to FilmMaker shortcut can be 
installed by re-starting the FilmMaker install. An option will be provided to install only 
the shortcut, rather than the entire FilmMaker package.

Fig. 4  - For a job that is composed of separations, click the Pages 
button to open the Page Manager dialog. Individual separations can 
then be toggled OFF, which will prevent them from being printed.
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1. Verify that the PhotoShop design is in either CMYK Colour mode (for CMYK 
separations), or Multichannel mode (for CMY separations).

From the Image menu, choose from the Mode flyout.

2. Use the Channels palette to control which separations to print.

The Channels palette is activated via Windows menu >> Channels. Click the eye 
icon beside each channel to show/hide its contents.

3. Choose File menu >> Automate >> Send to FilmMaker.

4. The Send to FilmMaker dialog will open, which is used to choose the queue that 
will receive the print job.

5. When the job is held within FilmMaker, the Visual Print Manager provides controls 
for inspecting the individual separations.

separaTions in Coreldraw®

Note: The following procedure was written using CorelDraw X5. For other 
versions of CorelDraw, please refer to the CorelDraw help file.

1. From the File menu, choose Print to open the Print dialog.

2. From the Printer drop-list, choose the printer that was installed through FilmMaker.

3. The printer comment should indicate that it is a “FilmMaker,” “VPM” or “CADlink” 
type of print destination.

4. Click the Colour tab.

5. Click the Print separations option. The Separations tab will now be available.

6. On the Separations tab, there are a checkboxes beside each colour channel, which can 
be used to choose the separations that will be printed.

7. The Use advanced settings checkbox determines how halftones will be applied, as 
follows:

Use advanced settings = ON (ticked)
(Recommended) This enables custom halftone settings that can be 
adjusted by clicking the Advanced button. Refer to the CorelDraw 
help file for an explanation of these controls.

Use advanced settings = OFF (unchecked)
This will use the halftone settings that have been set within FilmMaker.

8. Once the Print dialog settings are ready, click the Print button to print the 
separations to FilmMaker.

FilmMaker Quick Start
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separaTions in illusTraTor®

Note: The following procedure is valid for any of the Illustrator CS series.

1. Before creating separations, verify that the design is in CMYK colour mode.

 From the File menu, choose Document Colour Mode >> CMYK Colour.

2. From the File menu, choose Print.

3. The Print dialog will open.

4. From the Printer drop-list, choose the printer that was installed through 
FilmMaker.

5. On the left-hand side of the Print dialog are several categories of controls.

The categories are General, Setup, Marks and Bleeds, Output, Graphics, Colour 
Management, Advanced, and Summary.

6. Click the Output category of controls.

7. Set the Mode, Emulsion, and Image according to your workflow.

8. Beside each colour channel is a printer icon. Tick these icons to indicate the 
channels that should be printed as separations.

9. For each colour channel, double-click to edit the halftone settings. Refer to the 
Illustrator help file for an explanation of these controls.

10. Click Print to print the separations to FilmMaker.

Working with Separations and Halftones
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overvIeW - fIlmmaker InTerfaCe

maIn WIndoW

The main elements of the FilmMaker window (Fig. 5) are:

 ☐ A standard Menu Bar that provides the main FilmMaker controls.

 ☐ The Queue menu provides controls for adjusting FilmMaker parameters.

 ☐ The Jobs menu provides controls for adjusting selected print jobs.

 ☐ The Devices menu provides management for printers.

 ☐ The Tools menu provides access to advanced RIP settings.

 ☐ Below the Menu Bar, a Toolbar provides basic (Start / Stop) controls.

 ☐ Below the Toolbar are tabs for switching between queues.

 ☐ A list of received print jobs that are ready for printing.

 ☐ A list of previous jobs that have been archived for later reprinting.

 ☐ A Preview Pane (Visual Print Manager) that shows how jobs will be positioned 
on the media.

 ☐ A Media Settings pane that provides controls for scaling, rotating and 
positioning the selected job.

FilmMaker Quick Start
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Queue menu

When print jobs are received by FilmMaker, they are added to the queue of active jobs. 
The Queue menu contains basic controls for starting, stopping, and scheduling of print 
jobs.

 ☐ Manage Queues – Create a queue, or change the port or printer of an existing 
queue.

 ☐ Start – Process jobs as they are received in queue. Scheduling settings apply to 
received jobs.

 ☐ Stop – Hold all jobs in queue, regardless of Scheduling settings.

 ☐ Clear Job Errors – Reset any errors that were reported, such as paper out.

 ☐ Ink Density Test Page – Print targets to determine optimum ink density.

 ☐ Properties – Open the Queue Properties dialog.

Jobs menu

The Jobs menu contains controls for printing, previewing and deleting print jobs.

 ☐ Restore jobs – Manage archived print jobs.

 ☐ Select all – Selects all jobs in queue.

 ☐ Select none – Clear current selection.

 ☐ Remove – Delete the selected job.

 ☐ Rename – Change the job name.

 ☐ Open Page – Discard the spool data, such that individual jobs can be scaled, 
rotated, etc.

 ☐ Locate Job – Find the job in the Preview Pane.

 ☐ Release – Release a held job.

 ☐ Hold – Stop the job, regardless of whether queue is stopped.

 ☐ Abort – Cancel the print job.

 ☐ Clear error – Reset any errors that were reported, such as paper out.

 ☐ Add to Layout – Move an unscheduled job into the active list, and show in 
Preview Pane.

FilmMaker Quick Start
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 ☐ Print – Send job to the printer.

 ☐ RIP Only (Preview) – Spool the print data without sending to printer. Once 
spooled, the print data can be previewed.

 ☐ Generate Preview Image – If thumbnails have been turned off, then create a 
preview.

 ☐ Properties – Open the Job Properties dialog.

devICes menu

The Devices menu contains controls for managing printers, print modes, and page sizes.

 ☐ Manage Devices – Open the Manage Devices dialog, which is used to add 
support files for new printers, and check for support file updates.

 ☐ Manage Print Modes – Copy and edit print modes for a given printer.

 ☐ Manage Print Media – Define media dimensions in terms of sheets, rolls, and 
templates.

 ☐ Printer Properties – List printer settings.

 ☐ Print Test Page – Choose target charts for testing the printer output.

Tools menu

From the Tools menu, choose Options to open the Options dialog. The available tabs are 
as follows:

 ☐ General – Basic controls for customizing the FilmMaker interface.

 ☐ Storage and Archiving – Indicates location of production and archive files.

 ☐ Processing – Spool extra jobs whilst waiting for the current print job to finish.

 ☐ Preview Options – Adjust the quality of thumbnail images that are used to 
represent jobs.

FilmMaker Interface
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WorkfloWs - PrInTer seTuP

geTTIng The laTesT uPdaTes for your PrInTer

To obtain the latest support files for your printer:

1. Ensure your Internet connection is active.

2. From the Devices menu, choose Manage Devices. The Manage Devices dialog 
will open.

3. Click the printer name that will be checked.

4. Click the Check for online updates button. If updated support files are 
available, then the Update printers button will become available. 

5. Click the Update printers button to proceed with installing updates.

seTTIng The Page sIze

The page size is the size and margins of the loaded media, which will be used for 
positioning of jobs in the Visual Print Manager. The page size is set as follows:

1. From the Queue menu, choose Properties.

2. On the Media Setup tab, set the Type of media.

 ☐ Roll media - Preview jobs according to a specific roll width.

 ☐ Fixed sheet media - Preview jobs in terms of the sheet width and height.

3. From the Name drop-list, choose a preset media.

CreaTing a CusToM page size

In the following procedure, the Printer Page Setup dialog is used to create page sizes that 
can be selected in your design application.

1. Choose Queue menu >> Manage Queues.

2. Under the Control Panel column, click the Install button for the given printer.

3. Click Close to close the Manage Queues dialog.

4. From the Tools menu, choose Options.

5. On the General Interface Settings tab, set the display units in which page sizes 
will be defined.

6. Click Save and Close to close the Options dialog.

Workflows - Printer Setup
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7. Select Devices menu >> Manage Print Media.

8. From the Show media for drop-list, choose the printer name.

9. The existing page sizes for the printer will be listed.

10. Click the Add new print media button.

11. From the Create New Media dialog, choose either Roll or Sheet.

12. Complete the parameters for the given media.

seTTIng The layouT and sChedulIng

The following sections contain brief summaries of layout and scheduling controls that 
affect how jobs are processed when received by FilmMaker.

THe sTarT Queue and sTop Queue buTTons

These buttons are located within the main toolbar controls that are beneath the menus.

 ☐ Clicking the Stop Queue button will cause all jobs to be held, regardless of the 
scheduling settings within the queue properties.

 ☐ Clicking the Start Queue button means that all jobs will be processed according 
to the scheduling settings within the queue properties.

sCHeduling seTTings

Queue menu >> Properties >> Layout Manager tab

When a job is received by FilmMaker, it can be either a) held, b) ripped to printer data 
and held, or c) ripped to printer data and output to the printer.

 ☐ Hold - Do nothing with newly received jobs.

 ☐ RIP now, Print later - Spool jobs when received, but don’t output to printer.

 ☐ RIP and Print now - Automatically spool jobs and output them. Output will 
not occur if the Stop Queue button has been clicked.

FilmMaker Quick Start
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layouT jobs as THey arrive

Queue menu >> Properties >> Layout Manager tab

When jobs are received, the default behavior is that they are “scheduled” (i.e., put in the 
active list, and positioned in the Visual Print Manager). However, this behavior is toggled 
per the “Layout jobs on page as they arrive” checkbox.

 ☐ ON = incoming jobs are placed in the active list and Visual Print Manager

 ☐ OFF = place jobs in the unscheduled list

layouT Mode

The Layout Mode controls define how jobs are nested (i.e., collected and repositioned to 
conserve media) in the Visual Print Manager. When the collected jobs fill an entire sheet 
(or roll), the page is closed and printing can begin. For jobs that are nested automatically, 
you can specify that printing begins when a certain portion of the media is full.

1. From the Queues menu, choose Properties.

2. On the Media Setup tab, set the Type to either Roll media, or Fixed sheet media.

3. On the Layout Manager tab, the Layout mode drop-list will now be available.

 ☐ Manual – Add jobs to Visual Print Manager without attempting to conserve 
media.

 ☐ Auto Page – Append a page break to each job as it is received.

 ☐ Auto Nest – Reposition newly received jobs to conserve media. When you are 
ready to print, right-click an empty portion of Visual Print Manager and choose 
Print.

Note: If jobs have not been nested (i.e., Manual or Auto Page), then the jobs can 
still be nested by right-clicking an empty portion of Visual Print Manager and 
choosing Automatic Nesting >> Auto Nest All Content.

page overlay

Queue menu >> Properties >> Layout Manager tab

If the “Process multiple page jobs as overlay” checkbox has been ticked, then the colour 
layers within a job (i.e., CMYK and spot colour layers) will remain “stacked,” as opposed 
to being nested as separate jobs.

Workflows - Printer Setup
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ouTPuT PorT

1. From the Queue menu, choose Manage Queues.

2. The Queue Manager dialog will open.

3. For the given printer, the Port column indicates the output port.

4. To change the port, choose a port from the drop-list.

5. Click [...] to change the port settings.

Of the various port settings described in the following sections, the USB Port is 
recommended for output from FilmMaker. Other port methods are described in the 
electronic help file.

usb porT

This is the recommended output port to use with FilmMaker.

A Universal Serial Bus (USB) port has the benefit of allowing new hardware to be added 
without configuration concerns or hardware conflicts. In addition, a USB device may be 
added without requiring the workstation to be restarted.

1. When the Epson printer is connected to the computer via its USB port, 
Windows will automatically detect the USB printer.

2. In FilmMaker, the USB port name for this printer should now be available.

3. From the Queue menu,  choose Manage Queues.

4. The Queue Manager dialog will open.

5. From the Port column drop-list, choose the USB port that is named specifically 
for your Epson model. 

Example: For the Epson 4800, the USB port will be listed as “EpsonStylus Pro 
4800_USB00X+port name.”

Note: Depending upon advanced settings within FilmMaker, it is possible 
that there is a secondary “USB00X” port (or “LPTUSB1” in the case of 
Belkin Adapters) that is available. Do not choose either of these secondary 
ports, unless requested to do so by Tech Support.

FilmMaker Quick Start
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file porT for Tiff ouTpuT

FilmMaker can be configured to output TIFF files instead of spooling printer data. This 
is typically done when either a printer driver is not available, or the printer is explicitly 
designed to receive TIFF files.

1. Choose Devices menu >> Manage Devices.

2. Click the Add Printer button.

3. The Printer and Queue Setup Wizard will launch.

4. When prompted to choose a printer, browse the list for available “TIFF” printer 
drivers. Examples of possible printer names are:

 ☐ TIFF Output 1200dpi (typically DTP output)

 ☐ TIFF Output 2400dpi (DTP+)

 ☐ TIFF Output 3600dpi (XL+)

 ☐ TIFF Output 4800dpi (LFP+)

Note: The numeric values indicate the maximum resolution that the 
“TIFF” printer driver supports. To choose a resolution that is less 
than this maximum, refer to the Printer Options tab of the Queue 
Properties dialog.

5. After choosing the TIFF printer driver, proceed with the remainder of the 
wizard.

Note: The TIFF printer drivers will automatically separate a composite job 
into CMYK channels.

Workflows - Printer Setup
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WorkfloWs - managIng PrInT Jobs

sendIng a PrInT Job

Printing to FilmMaker is like printing to a desktop printer. For example, suppose that 
your Windows application uses the standard Print dialog.

1. From the Windows application File menu, choose Print.

2. The Print dialog will open.

3. Choose the name of your printer from the drop-list.

4. The printer description should indicate that it is a “FilmMaker” type of 
print destination, which indicates that print jobs will be processed through 
FilmMaker.

5. If the printer description does not indicate “FilmMaker,” then search for another 
printer name from the drop-list.

6. Click OK to send the print job.

sTarTIng and sToPPIng PrInT Jobs

When print jobs are received by FilmMaker, they can be either printed immediately, or 
they can be collected for later printing. The main controls for controlling print jobs are 
the Start Queue and Stop Queue buttons (available from the FilmMaker toolbar). The 
Start Queue and Stop Queue commands are also available under the Queue menu.

If the Start Queue button has been clicked, then print jobs will be printed immediately. 
If the Stop Queue button has been clicked, then print jobs will be held until manually 
released.

A held job can be printed by right-clicking the job and choosing Print from the context-
menu. Alternatively, select the job and choose Print from the Jobs menu.

In addition to the Start Queue and Stop Queue buttons, the scheduling settings also 
control whether a job is printed or held. The scheduling controls are set via Queue menu 
>> Properties >> Layout Manager tab.

PrInTIng To a hoT folder

The Hot Folder is simply a directory on the workstation hard drive that will be monitored 
for new print (i.e., PostScript) files. If any print files are placed in the directory, then these 
will be added to the queue as new print jobs.

Typically, the Hot Folder is used by other graphic designers on your computer network. 
They will copy their jobs into the Hot Folder, and your workstation queue will then be 
able to process those jobs. However, please note that other graphic designers will need the 
appropriate file access permission (as granted by your network administrator) to copy files 
into the hot folder.

Workflows - Managing Print Jobs
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In FilmMaker, a hot folder is designated as follows:

1. From the Queue menu, choose Properties.

2. On the Queue Properties dialog, click the Hot Folders tab.

3. Tick the Enable queue hot folder checkbox.

4. A browse dialog will open.

5. Choose a directory and click OK.

When a PostScript job is placed within the hot folder, FilmMaker will use print mode 
settings that are contained within the PostScript file. If the print mode settings are 
missing or incomplete, then the Queue Properties will be used to complete missing 
settings.

PrevIeWIng PrInT daTa

Print data can be examined on-screen prior to printing. This is typically done in order to 
confirm the print data that is available in each colour channel.

For example, suppose that a greyscale image needs to be printed, and the expectation 
is that only the black (K) channel will receive print data. This can be confirmed in the 
following manner:

1. Click the Stop Queue button to pause the greyscale-only print job in the queue.

2. Right-click the job and choose RIP Only.

3. When the job has finished spooling, its Status will indicate “Holding [Job 
spooled]”

4. Right-click the job and choose View RAW data.

5. Click the Plane Select button. Each of the colour channel checkboxes will be 
checked.

6. Clear the Black checkbox.

7. The preview should now be blank because the CMY channels are not being sent 
data for a greyscale-only job.

Note: Colours appear differently on monitors than they appear when 
printed. As a result, the View Raw Data feature will not show colours on 
the screen exactly as they will appear when printed.

Note: A monitor display is not capable of previewing variable dot output 
because a monitor display contains only one size of pixel on-screen. 
Further, the limited number of monitor pixels may cause the preview to 
appear faded, though this fading will not be present in the actual print.
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Job reserve Tab and arChIvIng

From the main FilmMaker window, the Reserve List is a short list for your frequently 
printed jobs. Sending a print job involves compiling a PostScript file into a spool file, and 
then the spool file is sent to the printer. When a job has been completed, it can be added 
to the Reserve List as a PostScript and (optionally) spool file for reuse.

 ☐ Enable job reserve (Fig. 6) - When a job has completed printing, its PostScript 
file will be added to the Reserve List.

 ☐ Save spool file on job reserve - Enabling this option will cause the compiled 
spool file to be reserved (i.e., avoid spending time compiling the PostScript into 
a spool file).

Note: Where the spool file has been archived, re-sending the job does not 
require the time that was spent compiling the spool file (potentially several 
minutes, depending on the workstation and the complexity of the print).

Note: A spool file requires comparatively much more hard drive space than 
the corresponding PostScript file.

Archiving Jobs for Future Reuse
In addition to reserving jobs for later use, jobs can be archived as a combined JBK file that 
contains both the job and log data, such that the JBK can be safety stored (i.e., backups) 
and then restored at a later date. Restoring jobs in this fashion eliminates time spent re-
spooling a file, and avoids any “guess work” related to the job settings, etc. Archiving also 
preserves the log and notes related to the job, such that job specifics can be referenced.

Setting the Archive Location
The archive location is the directory where archived jobs will be stored. This needs to be a 
location that can be accessed later to restore the given job.

1. Go Tools menu >> Options >> Storage and Archiving tab

Fig. 6  - On the Queue Properties dialog, click the Job Reserve 
tab. After a print job has been completed, these settings can 
save the spooled print file for printing additional copies later.
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2. Near the bottom of the tab, the location for job archiving is indicated.

3. To change the archive location, click the ellipsis button.

Archiving a Job
To archive a job, the job must be in either the Active List or Reserved List.

1. Select the job and then choose Jobs menu >> Archive to disk.

2. The archived job will appear as a JBK file in the archive location.

Loading an Archived Job
Loaded jobs will be placed in the active queue.

1. Click the queue tab to make it active.

2. Go Jobs menu >> Restore Jobs.

3. The Restore Job Tickets dialog will list the available archives.

4. Select the desired archive and click the Restore Archive button.

WorkfloWs - advanCed rIP seTTIngs

rIP memory alloCaTIon

Tools menu >> Options >> RIP tab

A large job size with high resolution can require considerable memory resources to process 
and print the job. A possible solution is to evaluate whether a lower print resolution is 
appropriate for the job. Alternatively, the RIP memory allocation can be increased (within 
bounds of the physical computer memory).

rIP sysTem PrIorITy

Tools menu >> Options >> RIP tab

When a software application is launched, the operating system (i.e., Windows) assigns 
a priority level that regulates the amount of time shared amongst different applications. 
Normally, processes are assigned equal priority levels, but modifying the priority of 
individual processes is acceptable when this improves the overall performance.

If the RIP System Priority is increased, then print jobs will be processed faster, though 
this will cause all other software applications to run slower. Other applications will simply 
require more time in order to complete their operations.

Conversely, if the RIP System Priority is decreased, then print jobs will require more time 
to complete.
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ConCurrenT rIPPIng

Tools menu >> Options >> Processing tab

Though FilmMaker can compile a PostScript file into a spool file quickly, there is still 
time required to send the spool data to the printer (say over a network). In addition, the 
printer has a physical limit with respect to how quickly ink can be laid upon the media.

Instead of waiting idle for a spool file to be completely received by the printer, the queue 
can begin creating spool files for subsequent print jobs concurrently. However, please note 
that only one spool file is being compiled at any given time. The Maximum number of 
concurrent jobs limits the number of spool files that can be compiled in advance of the job 
that is currently being spooled.

resoluTIon

Note: This is an advanced feature that is hidden per Tools menu >> Options 
>> General tab >> Show advanced settings.

Queue menu >> Properties >> Printer Options tab

By default, advanced Queue Property dialog settings are hidden, so that new users are 
presented with a streamlined interface that is easier to understand. Though Resolution 
is set for a queue during the Printer and Queue Setup Wizard, this setting is otherwise 
unavailable, unless the advanced settings are enabled.

PerformanCe

Note: This is an advanced feature that is hidden per Tools menu >> Options 
>> General tab >> Show advanced settings.

Queue menu >> Properties >> Performance tab

For most cases, the Resolution Reduction slider should be OFF. The Resolution 
Reduction slider is used to reduce the resolution of the data being spooled, thereby 
reducing the size of the required spool data. For text and line art, it is likely that half of 
the resolution data can be discarded without impacting the appearance of the printed 
output. However, avoid reducing the resolution with images (i.e., gradients that utilize 
halftones), since the quality can deteriorate quickly.

If the Intelligent Resolution Reduction checkbox is ticked, then the Resolution 
Reduction feature will be applied automatically using a sophisticated set of criteria.

Workflows - Advanced RIP Settings
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In-rIP seParaTIons

Note: This is an advanced feature that is hidden per Tools menu >> Options 
>> General tab >> Show advanced settings.

Queue menu >> Properties >> Calibration Control tab

In-RIP Separations are enabled by default when a new queue is created. However, 
FilmMaker will only create separations for jobs that have not already been prepared as 
separations.

Whereas it is often the case that your graphic design software can create separations, In-
RIP Separations will cause the FilmMaker RIP to automatically generate separations for 
the CMYK planes, plus any spot colours that are present.

Primarily, the advantage of In-RIP Separations is that separations can be generated from 
(say) a PDF file, rather than needing graphic design software to generate the separations 
for you. In addition, you can specify the halftone for each separation.

Note that In-RIP Separations have two Curve Set options that are used when your 
workflow involves twin parallel printing processes. This allows you to adjust the ink levels 
of each process independently.

 ☐ Calibration - Adjust this set of curves for your prepress proofing, or for printing 
the customer proof that will be used for approval before entering full production. 

 ☐ Press Calibration - Adjust this set of curves for your main print production run.

JITTer

Queue menu >> Properties >> Halftones tab >> Jitter button

For the dots within a halftone pattern, the Jitter feature introduces minuscule distortion 
to the dot shape, such that an overall pattern within the dots is less discernible.

For example, considering a circular halftone dot at a particular tint percentage, close 
inspection of the halftone would normally show a regular pattern of small circles. By 
enabling the Jitter feature, each circular dot would be slightly distorted (e.g., one circle 
with a slight bulge on a side, another circle with slight depression on another side).

 ☐ Halftone Level - This refers to the increasing size of a halftone cell, from an 
empty cell (0% tint) to a completely filled in cell (100% tint). 

 ☐ Jitter Factor - This is the amount of randomness that should be applied within a 
given  range of the Halftone Level.

By default, there is zero jitter for all tint percentages, as indicated by the flat horizontal 
line. However, if you observe that your prints have a discernible pattern within (say) the 
midtones (10-90%), then you can increase the jitter for that range and perform a test 
print to observe improvements (Fig. 7). Jitter can also be used in the highlight (0-10%) or 
shadow (90-100%) regions to help retain detail.
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Fig. 7    - From the Halftones tab, click Jitter to adjust the amount of halftone dot 
distortion that will be applied. In this example, jitter will be applied to the midtones.
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aPPendIX a - PrInTer noTes

PaPer CheCks

When working with clear film, it can be helpful to disable the paper sensor within the 
printer, since the sensor will not typically detect the clear film consistently.

Please refer to your operator manual for how to turn off the paper checks. As an example, 
the paper checks can be turned off for the Epson 4800 and 4400, as follows:

1. On the printer control panel, press the menu button to access Printer Setup on the 
display.

2. Press the menu button again, and then use the down arrow to locate each of the 
following and set them to OFF.

 ☐ PPR SIZE CHK

 ☐ PPR ALIGN CHK

 ☐ SHEET SIZE CHK

alTernaTIve Ink Channels

Not all printers are capable of printing black from an alternative channel effectively. For 
example, the Epson 1100 has CMY print heads that are much smaller than K, which 
would cause slow printing that would not typically be appropriate for a production 
environment.

ePson r1800
Note: For the Epson R1800, it is recommended that sheet feed media be used 
instead of rolls.

There are two main categories of print modes for the Epson R1800: Clear Film and 
Waterproof Film.

 ☐ Clear film is typically less expensive than waterproof film. However, clear film 
print modes are exceptionally slow because this media has low dot gain that 
requires more time to absorb ink. Further, the overall ink density of clear film 
will be lower than waterproof film.

 ☐ In comparison, “waterproof film” is literally waterproof, and it can absorb much 
more ink than clear film. Consequently, waterproof film can be used at lower 
(i.e., faster) resolutions and provide higher ink density.
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ePson 4400, 7400, and 9400
Note: This section also applies for the 4450, 7450, and 9450 printers.

These print modes are designed for use with UltraChrome inks, and there are three 
categories: Colour Modes, Halftone Colour Proof, and Separations. All of these print 
modes are optimized for the best printing speed and ink density.

filMMakerinks

The FilmMakerInks print modes are for printing separations to waterproof film (see 
comments under the Epson R1800 section). Note that there are no density settings 
indicated in the print mode names, and that using the incorrect film will risk ink density 
issues (e.g., ink bleed).

Each print mode name indicates its resolution and the maximum lpi halftone. As with 
print mode resolutions for the Epson R1800, a higher resolution requires more printing 
time.

The FilmMakerInks print modes use variable dot halftones to provide faster printing 
and higher lpi halftones than is possible at lower resolutions. However, to use these print 
modes, the printer must be configured with 4xFilmMakerInks cartridges, rather than light 
inks.

Colour Modes

These are full colour print modes that use the CMYK cartridges. These print modes are 
provided for using the Epson as a high quality colour printer, as opposed to typical colour 
separation work. These print modes are appropriate for providing a customer proof.

HalfTone Colour proof

Like the Colour Modes collection, these are also full colour print modes that use the 
CMYK cartridges. However, these print modes will provide a more visible halftone 
pattern that emulates the appearance of a screen print.

ePson 4800, 7800 and 9800
Note: This section also applies for the 4880, 7880, and 9880 printers.

For each printer, there are three categories of print modes: FilmMakerInks, Colour 
Modes, and Halftone Colour Proof (see comments from the Epson 4400, 7400, and 
9400 section). All of these print modes are optimized for the best printing speed and ink 
density.

Appendix A - Printer Notes
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resoluTIon

The print mode resolution has the most dramatic effect upon print quality and speed. 
Higher resolution settings produce smoother gradients, though at a cost of longer output 
time.

Print modes are mainly distinguished according to their print resolutions (2880, 1440, 
and 720 dpi), as follows:

 ☐ [Slowest, Highest Quality] The 2880 modes are the highest resolution, which 
will obtain the greatest quality (clean dots and ink density) with your finest 
meshes. These modes support the highest mesh counts and should be good up to 
140 lpi halftones.

 ☐ [Fast, Excellent Quality] The 1440 modes provide a reasonable compromise 
between speed and quality. The 1440 modes are faster than 2880 modes, whilst 

roland vP540 rss
These print modes are designed for Agfa SelectJet media, and there are currently no colour 
print modes available. All of these print modes are optimized for the best printing speed 
and ink density.

aPPendIX b - PrInT modes

Note: In most cases, installing printer support files will include predefined 
queue information, such that there is no need to choose a print mode. However, 
the following information is provided for those that wish to understand both 
how print modes were previously used, and their naming conventions.

Print modes contain all of the printer configuration settings (resolution, printer options, 
ink levels, etc.) that are used with a given job. A broad selection of print modes are 
provided with FilmMaker for commonly used media and ink.

When using the Printer and Queue Setup Wizard, you are indirectly prompted to choose 
a print mode on the Printer Configuration page, where the Resolution and Ink Setup 
are chosen. Your choices within the wizard are intended to be simpler means than setting 
the Print Mode via Queue menu >> Properties >> General tab.

Print modes are differentiated by their names, where the name of each print mode 
indicates its resolution, density and (print) direction.
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still providing clean dots and good ink density. These modes support up to 
about 100-120 lpi halftones.

 ☐ [Fastest, Reasonable Quality] The 720 modes provide the absolute fastest 
production times. However, though the ink density will be acceptable, the 
output quality will be less than optimum. These modes are acceptable for fabric 
printing (e.g., T-shirt printing), with support for up to 80 lpi halftones.

densITy

The density is expressed as a short code that indicates the relative volume of ink when 
compared to an equivalent print mode. For example, if two print modes have the same 
name, except that one is “SD” (Single Density) and the other is “DD” (Double Density), 
then the latter print mode will apply more ink.

 ☐ SD - Single Density

 ☐ DD - Double Density

 ☐ TD - Triple Density

 ☐ MD - Maximum Density

There is no simple formula that indicates the precise difference between density settings. 
The general rule is that SD has the least ink volume, DD is greater than SD, and so on:

SD < DD < TD < MD

The choice of ink density depends upon the job in question and the working environment 
(e.g., humidity, film storage conditions). Note that increasing the amount of ink will also 
increase the drying time, so an adequate system for drying film is required.

dIreCTIon (sPeed)
The direction indicates whether the print head will lay down ink in a single direction 
(Uni-directional), or in both directions (Bi-directional). Printing bi-directionally will 
typically require half the time of uni-directional, though can risk printing issues, such as 
banding or over inking.

Due to the reduced printing time when printing bi-directionally, the direction is often 
interpreted as a measure of the print mode speed.

 ☐ HS - High Speed (bi-directional printing)

If the “HS” code is absent, then the print mode is assumed to be uni-directional.

Appendix B - Print Modes
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